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Introduction

When you do iSeries™ project based development you will want to work in the
iSeries Projects perspective. This perspective serves two main purposes, hamely for
performing iSeries offline development on Windows® clients and for enabling team
development.

Offline development allows for a disconnected mode of development where a live
connection to a host is only required when code updates or builds are needed.

Team development is needed when code changes need to be shared between a
team of developers and synchronization of these changes is needed as part of the
development cycle. Team development is not covered in this tutorial.

Typically, you create local source physical files and members and edit them locally.
You can also download existing members from any remote library into your
project. Once done with the local editing, you can submit a build that will push all
your changes to the associated library of the iSeries Project and perform a build on
the remote members. The code pushed to this scratch library is only pushed there
for the purpose of performing that build. If source code management is needed,
the iSeries Project could be associated with any Team provider, for example,
Rational® ClearCase® LT version control, that is installed with Development Studio
Client.

This tutorial teaches you about disconnected development. A live connection is
required only when code updates or builds are needed, or when you need to view
remote resources for a project. If you are working on a remote laptop, or are at
home with a slower connection, you might choose to work in disconnected mode.
With this option, you explicitly copy files locally while you have a live connection,
close the connection, work on the files at your leisure, and upload them back to
the server once you have finished. Then you can run another verify to locally
check your source code for syntax and semantic errors and submit a compile only
when your code is error free.

Prerequisites
In order to complete this tutorial end to end, you should already have completed

the Tutorial: Maintaining an RPG application using Remote System Explorer and
have working knowledge of the following:

+ Basic Microsoft® Windows operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations.

It is also useful, but not necessary, for you to have basic knowledge of ILE RPG.

Time required

To complete the modules in this tutorial, you will need approximately 1 hour.

Learning objectives

© Copyright IBM Corp. 2001, 2005 \'%
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This tutorial is divided into 3 modules, each with their own specific learning
objectives. You can choose to complete one or all of the modules. Each module
contains several exercises that must be completed in order for the tutorial to work

properly.

Chapter 1, “Module 1. Starting the product and connecting to an iSeries,” on page|
g teaches you how to start the product and how to configure and create a
connection in order that you can see the payroll application source code. In this
module, you will:

» Start the product

» Set the workspace location

» Set up a connection to an iSeries system
* Add a library to your library list

[Chapter 2, “Module 2. Working with source in disconnected mode,” on page 9
teaches you how to make source available for offline or disconnected development.
Here you will learn to edit and verify the source disconnected from the iSeries
system. You will also learn how to compile your changed member. In this module,
you will:

* Download selected files or members to your workstation

* Verify download source

* Launch the editor on a local source member under an iSeries Project

» Put an iSeries connection into offline mode

» Edit a local source member under an iSeries Project

* View an outline of the local RPG source

* Open a local DDS member for edit from the iSeries Projects Navigator
» \erify changed RPG source

* Compile a single member

[Chapter 3, “Module 3. Creating and Building an iSeries Project,” on page 21|
teaches you another approach to working with iSeries Projects. You will learn how
to create a new iSeries project, create new physical files and source members and
how to populate the iSeries projects with members. You will also learn how to
show remote objects or local objects or both and how to submit a build for the
entire project. In this module, you will:

» Create a personal development library (single developer sandbox)
» Create an empty iSeries Project

» Populate the empty iSeries Project

» Select a build style for the iSeries Project

* Build the iSeries Project

* View all the remote objects in the iSeries Project Navigator

* Filter the objects to remove the remote only objects from the iSeries Project
Navigator

* Remove the Local/Remote Flags from the iSeries Project Navigator
» Push only a changed file to the iSeries

When you are ready, begin [Chapter 1, “Module 1. Starting the product and|
[connecting to an iSeries,” on page 1]




Chapter 1. Module 1. Starting the product and connecting to
an iSeries

This module teaches you how to start the product and create and configure a
connection to an iSeries system.

In this module, you will:

» Start the product

» Set the workspace location

» Set up a connection to an iSeries system
* Add a library to your library list

Exercises

The exercises within this module must be completed in order.
« [“Exercise 1.1: Starting the product”]

« [“Exercise 1.2: Configuring a connection to an iSeries system” on page 2|
« [“Exercise 1.3: Connecting to an iSeries system” on page 4|

Time required

This module will take approximately 10 minutes to complete.

Exercise 1.1: Starting the product

To start the product:
1. Click Start on the task bar of your desktop

2. Select Programs > IBM® WebSphere® Studio > Development Studio Client
Advanced Edition for iSeries 5.1.2

hSphere Studio L4 LE Developrment Studio Client Advanced Edition for iSeries 5.1.2 #

# Devegpment Studio Client Advanced Edition for iSeties 5.1.2

Note: If the Advanced Edition Version of the product is not installed on your
workstation then you will not see the words "Advanced Edition” in the
Start menu.

3. A dialog will appear. Here you specify the name of the workspace where your
projects and other resources such as folders, subfolders and files that you are
developing in the workbench will reside.

WebSphere Studio _)_(_l

WebSphere Studio stores wour work in a directory called a workspace. You can change the warkspace each time
wou start \WebSphere Studio. Specify the directom to use for this session:

|E:'\D0meﬂ‘t3 and Settingshsteckham'\My Documentsh BMwd SELAB 1] Browse... |

[T Use this workspace as the default and do not show this dislog box again

[ ok | cancel |

© Copyright IBM Corp. 2001, 2005



4. Use the same name of the workspace that you used for the Tutorial:
Maintaining an ILE RPG application with Remote System Explorer, for
example, RSElabXX (where XX is a unique number, for example your team
number), or use a different workspace.

5. Click OK to open the workbench.

'#! Remote System Explorer - Welcome - WebSphere D = jI:I| £|
File Edit Mavigate Search Project Run  Windels Help
- J {J | J % ‘* ﬁ |Remate System Explorer - Welcome - ‘WebSphere Devel

J a S - -
ml VLS [J= XS] e
Ef”kannt...tm * X x l Outline X
YRR Development St...
s 4| An outline is
= e | IThis page tells you what you should know before yor=—4 hot available.
- with WebSphere Development Studio Client Advance
b G,"}= sections below and click on the related links,
([= _ New Connection ® .
i - Windows. ., Get starte
| l ,g U To know what to do first, consult the Product Ov—
| . L L:n,.lx. = in the online help to decide how you can most efi
Unde LInix. ..
#-B Local..,
‘ A a KSeies = Develop iSeries applications
4 " ‘You can create and maintain RPG and COBOL ap
B Local toals in this development environment, Use the F
your iSeries objects, then use the built-in editing
need to do is create a connection. Once you ha
05400 members, v
| | | »
| 1 Remote System Details [+ & 2 = v x
< |»]
|[Remate Syste... | Team
| Properties WX
[|= 25 5
| Property | value
({2 | » | | Remate System Details | Tasks jiSeries Table Yiew |iSeries Cammands Log

You have started the product and set the workspace location and now you are
ready to begin [“Exercise 1.2: Configuring a connection to an iSeries system.”|

Exercise 1.2: Configuring a connection to an iSeries system

2
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Before you begin, you must complete [‘Exercise 1.1: Starting the product” on page|

When you first start the workbench and open a perspective, you are not connected
to any system except your local hard drive on your workstation.

Before you can work offline you need to connect to an iSeries system to download
the source files that you need.

You may skip this chapter if you want to use an existing connection from the
previous Tutorial: Maintaining an RPG application with Remote System Explorer.

To configure a connection:



1. In the Remote Systems New Connection shows the various remote systems
types you can connect to through the Remote Systems view.

[+ A% Windows.,.,
D Linux...

[l-Unix Unix...
I ocal..

Remote Systems | Team

2. Expand iSeries to configure a connection to an iSeries system.
The Name personal profile page opens if this is the first time you are creating a

connection.
x|
Mame personal profile
Uriquely name user profile E l

Welcome to Remote Systems. Connections can be sharable by the tsam or private to
wou, Enter a profile name to uniquely identify you From your team members, You will
decide for each new connection whether it is owned by the team profile or vour

profile.

Profile: | ifURICH

< Beck Next > B | cancel |

3. Click Next to accept the default value.
The profile defaults to the name of the workstation. Your profile will be
different from the one shown here.
The Remote iSeries System Connection page opens:

3
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Remote iSeries System Connection

Define connection information !

Parert profile: I‘:’LIRICH _:I

Connection name: | 5400a

Host name: <4003 _.) _vJ

Description:

IV Verify host name

<Back | nNext> [[ Finih | cancel [

On this second page you specify the information for your connection. The
cursor on this page is positioned in the Host Name field.

4. In the Host name field, type the name of your host system.

The Connection name is automatically filled with the host name. Leave it this
way. This name displays in your Remote Systems view and must be unique to
the profile.

5. Leave the Parent profile default value. You don’t need to change it.
6. Leave the Verify host name check box selected.
7. Click Finish to create your connection.

You have set up a connection to an iSeries system and now you are ready to begin
[“Exercise 1.3: Connecting to an iSeries system.”|

Exercise 1.3: Connecting to an iSeries system
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Before you begin, you must complete [‘Exercise 1.2: Configuring a connection to an|
iSeries system” on page 2|

After you configure a connection to an iSeries system, you can easily connect and
expand your new connection to show the subsystems. Subsystems are a function
grouping of the various types of remote resources that can be explored in the
remote system.



= AN New Connection
o A Windows,,.
B0 Linux...
[El-Unix Unix.,.
B Local...
EI--& iSeries...
; ] Connection created successfully, |
W B Local
=8y s400a
E-@h
[# 5 Work with libraries. ..
-5 Work with objects. .,
=% york with members. ..

‘W
[+ afp User lbraries

] gk iSeries Commands
-l iSeries Jobs
Ty IFS Files

4 | i

Remote Systems | Team

To connect to an iSeries system:

1. In the Remote Systems view, expand your new connection to show the
subsystems.

Now let’s work with a library in our library list and add the library that you’ll
be using in this tutorial:

a. Right click iSeries Objects and click Properties on the pop-up menu.

= Chiange Password
m Releasednteractive D
X 69 5 Verify Connection...
= N New Connect. .,
-4\ Disconmect
@ L Clear Password Cach
5 g‘ t Remote Servers
Ef ¢ ShowLog(®)..
“b Run Command, ..
B8 loca—— —

e gX iSeries Commands
- gffy i5eries Jobs
[ Ty IFSFiles

k=== i
b. Select Initial Library List on the left pane.

c. Type RSELABXX where XX is your unique workstation number, for example,
your team number in the Library field and click Add.

Chapter 1. Module 1. Starting the product and connecting to an iSeries 5



4P Properties for iSeries Objects o =]

- Command Execution Initial Library List
Envirgnment Yariables '

¢ Initial Library Lis ~Library list
- Ubrar i ESELARKE_—>

Library | Library Position | h
RSELABYA *LAST

Hemove

Mowe Up I

Meve Crawn

Current ibrary: | *USRPRF ~]

Initial command:

Restore Defaults | Apply I

" Cancel |

d. Click OK.

This will add the library RSELABxx to your library list every time you use
this connection.

Note: You can also change your library list using the pop-up menu items
Add Library List Entry or Change Current Library on the Library
list folder in the iSeries Objects subsystem. These changes are only
valid until you disconnect and only known to the Remote Systems
Communication server job.
2. Expand iSeries Objects if it is not already.
3. Expand the Library list folder.
Now the connection will be activated and you will be prompted for a user ID
and password.

x

System type: iSeries
Host name:  TORASG44

User ID; I WLAB:xx
Password: | R
¥ Save user ID

¥ Save password

| ox[;§| Cancel |

Enter your user ID and password.

Select the Save user ID check box.

Select the Save password check box.

Click OK.

Back in the workbench you will see the libraries in your job’s library list.

N o g s
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BH| 6| KT

=] ,& MNewy Connection =
[ Windaws..,
23] 6 Linux...
E-unis Unix,..
=B Local..,
=8y iseries...
: | Connection created successf
+ B Local
= 18y s400a
=g iSeries Objects
B work with libraries, .,
[ ".’i;' Work with objects...
l&] Tﬁ Work with members..,.
= Library list
#-l Qsvs.Hib.prod-sys
&Iy Qsvs2.Hib.prod-sys

1 I | | ™
-, QTEMP *iib test-usr
faa WPt 4N Vo e —lﬂ
»

4

Notice that the s400a node now has a small green arrow in the icon to indicate

it is an active connection.

Expand RSELABXxx to see the source files within this library. You will use some

of these files in the next chapter.

[#- ] CLCL *pgrn.clle

Bl [#] CLR1.*pgm.clle

G 7] MYCOMPILE  *parm.cl
[ [F] PAYROLL. *pgm.rpale

Bl [#] PAYROLLCZ *pgm.ct
- [F] PAYROLLD,*pam.cbl
[ [¥] PAYROLLG. *pam.rpg
&) [y COMPARE, *file.pf-st
- E EMPMST *file.pf-dta
51 [ EVFEVENT, *file.pf-di
=) 6 MSTDSP. *file, dspf

&) 6 MSTDSPZ, *File. dspF Ri
51 [E MYEMPMST. *file.pf-¢
- [E PRIMST *file.pf-dta

&) [Ey QCBLLESRC *file.pf-
- E) QCLSRC. *file.pf-src |
&1 By QCMDSRC. *file.pF-st
&1 E) QDDSSRC *file,pf-sr
=1 Ey QRPGLESRC. *file.pf-
E QRPGLESRCP.*file.p _

L B nechacT #Eile mE
A r

s |

You have added a library to the library list.

Module recap

You have completed [Chapter 1, “Module 1. Starting the product and connecting to|

[an iSeries,” on page 1]You have learned how to:

» Start the product
» Set the workspace location

Chapter 1. Module 1. Starting the product and connecting to an iSeries
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» Set up a connection to an iSeries system
* Add a library to your library list

Now that you have started the product, created and configured a connection, and
located the source code for the payroll application, you are ready to download
source to your workstation. Continue to [Chapter 2, “Module 2. Working with|
[source in disconnected mode,” on page 9

8 iSeries Projects



Chapter 2. Module 2. Working with source in disconnected
mode

This module teaches you how to download selected files or members in order that
you can work on these files disconnected from an iSeries. An iSeries project will be
created for you automatically. You will verify the downloaded source before you
disconnect. You will then disconnect from the iSeries. Next you will edit and verify
source on your workstation. Finally you will compile your source. During the
compile step you are automatically reconnected to the iSeries system.

In this module, you will:

* Download selected files or members to your workstation

* Verify download source

» Launch the editor on a local source member under an iSeries Project

» Put an iSeries connection into offline mode

» Edit a local source member under an iSeries Project

* View an outline of the local RPG source

* Open a local DDS member for edit from the iSeries Projects Navigator
» Verify changed RPG source

» Compile a single member

Exercises

The exercises within this module must be completed in order.

« |“Exercise 2.1: Making source available offline”

« [“Exercise 2.2: Editing local source members in disconnected mode” on page 13|
+ [“Exercise 2.3: Verifying RPG source in disconnected mode” on page 16|

+ [“Exercise 2.4: Compiling a member” on page 17|

Time required

This module will take approximately 20 minutes to complete.

Exercise 2.1: Making source available offline

You want to edit and verify your source on a workstation. You do not have an
existing iSeries Project. You can use the Make Available Offline action.

The Make Available Offline action downloads the selected files or members locally
to their corresponding iSeries project. The corresponding iSeries project has the
same host and the same library properties as the host name and the library of the
selected source physical files or members. If such an iSeries project is not found,
one will automatically be created.

To make source available offline:

1. Expand the RSELABXxx library (if it is not already) that contains the source files
that you want to work with offline.

© Copyright IBM Corp. 2001, 2005 9



2. Select the source physical files QDDSSRC and QRPGLESRC as you want the
members in these source files to be made available for offline development. You
can use the Shift key to make multiple selections.

10
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3. Right-click and click Make Available Offline on the pop-up menu.

(ol x|
File Edit Mavigate Search Project Run  ‘Window Help
5 -Ba60]f % %] s]5a -
=gl I e sta v x || Elwelcome X | out X
@RS &2 | ®F Deve...
- [ EMPMST *file.pf-dta A An
EVFEVENT *Filz of-dt a—r This page tells vou what you shnu: outline is
el with WebSphere Development Stu not
6% MSTDSP. file dspf sections below and click onthe rel | available,
6 M5TDSP2. *file. dspf
B PRIMST *File.pf-dta
i : Get started
E] E] QCBLLESRC. *file.pf-sr1 ® To know what to do First, con
(El QCLSRC *file.pf-sre in the online help to decide hc
- Ey QCMOSRC. *file.pf-src
Eh 5 VFFile, pf-sre T, * | applicatic
EfJorPGLE E GoTo ¥ |d mainkain F—
[ E] QRPGLESRCP . *file.pf- pment envi
REFMST.*file.pf-dta &% Refresh s, then use
] RONMST le.pfdta g =4 connes
. MYCOMPILE *cmd e
- iy QGPL.*ib.prod-usr s .
- -l wsSLABKX. Hib.prod-ust | fn Rename. . ’I';ﬁ:t:;)';“
) e User lbraries = ek _‘:I
= &k iSeries Commands Re] Cogly :
# @8 iSeries Jobs E faste 2 w %
& ¥y IF5 Files & Move... -
4 | 2+ 8 Delete...
Remote Systems [Team DDLIBLE command |
Bl Show in Table < added to the
- =,
| 5] Properties E 5 E{E o Cache Hle Descriptions ?:GS\"SLIBL St
| Property l Value | P? Find String. .. the mxsm'
Attribute  PF-SRC Change(B) ..
Mame QRPGLESRC Save : v
Humber ... 0
Source  RSELABEX N [
Status oK User Actions 4
Text add Tol P es Tab... ||SaﬂesCo‘..
Make Available Offline Make Avallable OFfline |

The iSeries Projects Question dia
4. Click Yes to proceed.

tﬁ: iSeries Projecks Question
A
€;

log opens.

all source members of the selected source files will be downloaded locally and
# added to iSeries project s400a_RSELABKK,

Proceed?

| Yes I Mo

x|




Rl Ll 5
= (@ s400a_RSELABR:
=-E} qpossrc

R fORPGLESRC

iSeries Project ...  Navigator |Bookmarks

The iSeries Projects perspective opens with your new iSeries Project named
s400a_RSELABXxx. This project is created for you automatically and the source
files QDDSSRC and QRPGLESRC are added to this project.

Note: If you want to add more source files later to this iSeries project, you can
use the Make Available Offline option again.

Now you need to verify that you have the latest cached source available before
you begin to work offline.

5. Expand QRPGLESRC and double-click PAYROLLG to open this source file in
the LPEX Editor.

6. Click Source and click Verify on the workbench menu.

Chapter 2. Module 2. Working with source in disconnected mode 11
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4P iSeries Projects - PAYROLLG.RPGLE - WebSphere Development Studio

Fil= Edit I Source Mavigate Search Project Run  Window Help

|SEIE T s k- - B[
|® & Prompt F4
= E@i  Synkax Check Al Yelcome O X ||| outlr x
% I“L' Cerl-Shift+y k (p(h
[ﬁ =@  Werify With Prompt... } - Press
e 5 0001 Fraxaxhrnd
g Convert All Ta Free-Farm 10002 F* DROCE
:mmtme”' 10003 F* DESCR
P Joeniaen 0004 P+
Show figlds
fcopynwg- b ]UUUS E‘********
10006 F* INDIC
ILERPG Hel * booo7 P* 50 -
Resequence All Lines 10008 F* 60 -
Refresh Ctr+F5 10009 F* 90 -
T ou00l0 E* KC -
iSeries Project Nav... |Navigator Bookmarks || g1 ¥ KD -
A8 Remote Systems « x| D00012 F* KE -
2G| e e | KF o | ;IJ
e N New Connection
EE Local | 4 ¥
E--‘ s400a
€| Series Error List 0 Ao w X
|10 | Message [ 5.4t Location | ¢
4] | »
| Remote Systems |Properties Tasks |iSeries Commands Log |Series Error List |

|

I |

This action will verify your member for syntax and semantic errors and any
errors will appear in the iSeries Error List and cache all information required
for subsequent offline verifys.

Now you are ready to disconnect from the iSeries server.

From the Remote Systems view, just below the iSeries Project Navigator,
right-click on the connection and click Disconnect All.



db iseries Projects - EMPMST.PF - WebSphere Development Studio Client Serie -0l x|
Fil= Edit Source Mavigaste Search Project Run  Window Help

J&""QP_?-_gllewfx-c.x-n\'ilﬁﬂuJ%,*.av |JB eu-:_-\::'"?."
@6 | m Golnto
| [Bgsenc ™ b | Dwele... | Zeawe... | Zpaw... [ b || ouir x
7 l_;J TR open inMew Window | | Row 1 Column 1
) @ [shounTab | AT A outine
Btz [=RE| 0ooool T 1l
 GPRefresh 000002 A+ EMpM iR
Expand 000003 A* DESC
Sefeniz 000004 A*  ENRC
i 000005 A*  DATE
o 000006 A* IS M
Copv 0oooo? Bk Ak ok ok g
“Move.., 0oooos A
9% Delete... ooooog A
! ooooio A
i Move bn ! oooo11 A
& Move Dol L goooiz A
A ;I_I
Verify program actio
|

iSeties Error List - 5., LABXK/QDDSSRCEMPMST) + X

[10 | Message 5]t Lo
4] | »
| Remote Systems ipmperties Tasks |iSeries Commands Log |iSerias Error List [

Disconnect all subsystems

Note: You can also put an entire iSeries connection, and all the contents
defined with that connection, into offline mode by right-clicking the
connection and clicking Work Offline on the pop-up menu. This method
of working offline prevents the Remote System Explorer from attempting
to connect to the iSeries server if a request is made for remote
information. For example, if you are verifying a local source file or
member in an iSeries project, the project would attempt to connect to the
server if the required information was not available in the cache. This
can be prevented by switching the connection to offline mode.

You have downloaded selected files or members to your workstation, verified
downloaded source, launched the editor on a local source member under an iSeries
Project and put an iSeries connection into offline mode and now you are ready to
begin [“Exercise 2.2: Editing local source members in disconnected mode.”|

Exercise 2.2: Editing local source members in disconnected mode

Before you begin, you must complete [“Exercise 2.1: Making source available|
[offline” on page 9

Chapter 2. Module 2. Working with source in disconnected mode 13
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Editing local source members under iSeries projects is the same as editing remote
source members in the Remote Systems Explorer. The LPEX editor can be launched
on any local member and the same functionality is available, such as the Outline
view, prompter and the content assist feature.

There is one major difference though when editing source members using the
LPEX editor in the Remote System Explorer perspective as opposed to using the
LPEX editor in the iSeries Project Perspective. When a source member is opened in
LPEX in the Remote System Explorer perspective, it is locked, and it cannot be
modified on the host while the local edit session is active. Any code changes that
you make locally will be saved to the host when the Save action is performed in
the LPEX editor.

On the other hand, when a member is opened in the LPEX editor in the iSeries
Projects perspective, the member is not locked on the host. It can be modified by
anyone with enough authority to the object. If you do a Refresh on the iSeries
Project, a double sided red arrow will indicate that the member has been modified
on the host. When you push changes back to the host, (something you will do
when you are connected again), you will be warned that you will be overwriting
remote changes, and you are given the chance to cancel the operation.

Now let’s edit the member PAYROLLG that you already have open in the editor.

To edit PAYROLLG:

1. In the PAYROLLG Editor window move the cursor to line 231 which contains
EXSR ACDESR.

2. Append an X to the EXSR op-code to make it EXSRX.

3. Click File > Save from the workbench menu to save this change.
You will fix this error later.

Displaying an outline of an ILE RPG member

The Outline view acts as an excellent resource when you want to edit RPG and
COBOL source in the Remote Systems LPEX editor. The Outline view displays a
structural outline of items defined in the source that you currently have open in
the Remote Systems LPEX editor window. With the editor active, you can expand
the file structure in the Outline view, and click various elements in the view to
jump to that location in the source itself.

To see an Outline view of your RPG source:
1. Click the PAYROLLG tab in the editor and click Refresh on the Outline view
toolbar.

The Outline view contains your source program in a tree view without the lines
containing logic.



aE
#1-C3) Indicators

= [%. Main Procedure
Ei--Ca Subroutines

Now you want to see more details of your source member.

Expand Files.

a s~ N

Expand the MSTDSP workstation file.
Expand the EMPSEL record format.
Double-click on any of the entries in the Outline view.

This will position the source editor accordingly.

Kl (] _'I':‘

Opening a DDS member

You can also edit DDS members locally from the iSeries Projects Navigator.

To open a DDS file member:

1. In the iSeries Project Navigator, expand QDDSSRC, if it is not already

expanded.
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2. Right-click MSTDSP member and click Open With.

As in the Remote System Explorer perspective, you now have the options to
open the Remote Systems LPEX Editor, the CODE Editor or the CODE
Designer.

You have edited a local source member under an iSeries Project, viewed an outline
of the local RPG source and opened a local DDS member for edit from the iSeries
Project Navigator and now you are ready to begin [‘Exercise 2.3: Verifying RPG|
[source in disconnected mode.”|

Exercise 2.3: Verifying RPG source in disconnected mode
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Before you begin, you must complete [‘Exercise 2.2: Editing local source members|
[in disconnected mode” on page 13

While you are disconnected from an iSeries, you can make certain that there are no
errors by invoking the Program Verifier. The verifier checks for syntactic and
semantic (compile) errors on your workstation so that you can guarantee a clean
compile when you are connected to an iSeries. The iSeries Error List window lists
the errors that are found and their severity, inserts the error messages directly into
the source and helps you to navigate between the errors.

To verify source:

1. Click the PAYROLLG tab.

2. Click Source > Verify from the workbench menu. (Similarly, you can also use
the Verify tool button B you need the source in the editor and the tab
needs to be selected for the button to be enabled.)

After a moment the verifier will display an iSeries Error List below the Editor
window.

3. Use the Error list to locate the error you created earlier and fix it.
4. Save the change to the source that you just made.
5. Verify the source again.

You have verified changed RPG source and now you are ready to begin
[2.4: Compiling a member” on page 17|




Exercise 2.4: Compiling a member

Before you begin, you must complete [“Exercise 2.3: Verifying RPG source in|

[disconnected mode” on page 16

So now that the code has been edited locally and verified, you are ready to
perform a single member compile on the source member in your iSeries project.

To compile a single member:

1. First change the preferences to compile interactively. Click Window >
Preferences from the workbench menu.

[+ Workbench
[+ Agent Contraller
[+ Ant
Euild Order
[# Componenkt Test
#- Data
[# Debug
[+-Help
[+ InstallfUpdate
Inkernet

¥= iSeries Projects
* Build and Compile

S v} 3 —
[+ Java

Logaing
[+ LPEX Editor
& Plug-In Development
[+ Profiling and Logging
+-RAD
[+ Remote Systems
[#- Server

-

=

| Build and Compile

Select the default build style For this workspace. All new
iSeties projects will be created using this style. You can
change this For & project in the project's properties.

Default build style:
Configure Templates... |

Command
FHONE

Pravided by 18M plugin "iSeries Projects - Remote Build
Styles Plugin® version 5,1,2

This build style will upload CL programs specified in the
configuration, compile them, and then run them to build this
project. The compile commands can be automatically
qenerated

I™ Run compiles as batch jobs:

es on remote system: | 7

Restore Defaults | Apply \J
]

mport... | Export... |

=10/ x|

N o ok wDdN

Expand iSeries Projects.

Select Build and Compile.

Clear the Run compiles as batch jobs check box.
Click OK.
Expand QRPGLESRC if it is not already.

Right-click PAYROLLG and select Remote Actions > Compile > CRTBNDRPG
on the pop-up menu.

Chapter 2. Module 2. Working with source in disconnected mode
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Now the connection will be activated and you will be prompted for a user ID
and password.

8. Enter your user ID and password.

Any local changes are uploaded to the same file in the associated library on the
iSeries system.

This action will compile your member and any errors will appear in the iSeries
Error List.

If you are not sure that the compile was successful, you can check the iSeries
Commands Log.

You could now run or debug your changed application.
You have compiled a single member.

Module recap

You have completed [Chapter 2, “Module 2. Working with source in disconnected|
[mode,” on page 9 You have learned how to:

* Download selected files or members to your workstation

* Verify download source

* Launch the editor on a local source member under an iSeries Project

» Put an iSeries connection into offline mode

» Edit a local source member under an iSeries Project

* View an outline of the local RPG source

* Open a local DDS member for edit from the iSeries Projects Navigator
» \erify changed RPG source

18 iseries Projects



* Compile a single member

Another way to work with iSeries Projects is to create a new project, populate that
project with members and build the entire project. Continue to [Chapter 3, “Modulg|
[3. Creating and Building an iSeries Project,” on page 21

Chapter 2. Module 2. Working with source in disconnected mode 19
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Chapter 3. Module 3. Creating and Building an iSeries Project

Instead of making remote objects available offline as you did with the Make
Available Offline option, you can create an iSeries Project and import or add
objects to that project. To import objects into an iSeries Project you must be
connected to an iSeries system.

This module teaches you how to create an iSeries Project and import objects into
that project. You will also learn how to show remote objects and filter out remote
objects. Finally you will learn how to build the full project.

In this module, you will:

* Create a personal development library (single developer sandbox)
» Create an empty iSeries Project

* Populate the empty iSeries Project

» Select a build style for the iSeries Project

* Build the iSeries Project

* View all the remote objects in the iSeries Project Navigator

* Filter the objects to remove the remote only objects from the iSeries Project
Navigator

* Remove the Local/Remote Flags from the iSeries Project Navigator
» Push only a changed file to the iSeries

Exercises

The exercises within this module must be completed in order.

» |“Exercise 3.1: Creating a scratch library”]

+ [“Exercise 3.2: Creating an iSeries Project” on page 23

+ [“Exercise 3.3: Creating source file and a source member” on page 25|
[“Exercise 3.4: Importing members into your project” on page 28|

« [“Exercise 3.5: Selecting the build style” on page 30|

+ [“Exercise 3.6: Submitting a build” on page 31|

[“Exercise 3.7: Showing remote objects” on page 34|

[Exercise 3.8: Filtering out remote objects” on page 35|

+ [“Exercise 3.9: Changing PAYROLLG again and submitting another build” on|

[page 36|

Time required

This module will take approximately 30 minutes to complete.

Exercise 3.1: Creating a scratch library

You will need an associated library when you create an iSeries Project in the next
exercise. The associated library is a "scratch” library on the remote iSeries system
that an iSeries project maps to. It is used for pushing code changes made locally to
the remote host and for performing builds on that remote host. It is expected that
this library is a "personal” library and the goal is that there should not be any need

© Copyright IBM Corp. 2001, 2005 21
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for any source in it to be edited directly on the host. It is meant to be a sandbox in
which a single developer can perform tasks.

To create a scratch library:

1. In the Remote Systems view below the iSeries Project Navigator, right-click
iSeries Objects and click New > Library on the workbench menu.

T W —
Fle Edt Souce Navigal ~Solnto N Library List Fikeht,,

= = Go To »
J B-HE88 |J ﬁ %Lbraryﬁltar...
@6 |m m » | & Open Member... N Object Fikter. .
T35 Open in New Window e
7 | iseries Pr... Navigator gsm«r e I\ Member Fiter..
= e L in
Re > || | Column 1
e e
|Th | ® @ s400a_RSELAB: Work With 4
47 Refresh
e F* PROGRAM N
il F* DESCRIPTT
Collepse p
Changs Password Frakxrkhhxhrrk
Releass [nteractive Job F* TNDICATOR
== Verify Connection... F* 50 - No r
1Beries ... |Navigator | et Bl SEO = Cane

’—m Disconnect F* 90 - Prot
Cleat Passward Cache

_& {-5% | o B = B B KC - End
B — Remote Servers [ 4
W L]
s showlog(®)..
#- N Mew Connectio Ry Command,..
& & Local
=8 s4002 Properties
Eﬁ) iSeries ¢ o
& &k iSeries Commands | | DatefTime Submitted | 30b
- BB iSeries Jobs Oct 6, 2004 10:17:00 AM  229629/STECKHAM|

* IFS Files

The iSeries Library page opens.
2. In the Library field, type Projxx.
|

5
iSeries Library

Create Library (CRTLIE) m
Library; | Projoc ]| Bromse... |

~Type
| " Production + Test

Text: |scratch library]

CRTLIB LIB(PROJ®X) TYPE(*TEST) TEXT('scratch library’)

<k | mext> [ Finih | concel [

3. Select the Test radio button to change the type of library to Test.



4. Type scratch Tibrary for the Text field.
5. Click Finish.
This will create an empty iSeries Library.

v X

=] a 54003 :l

= #-D iSeries Objects
[+ ':ﬁ: Work with libraries...
@ Ti_* Work with objects. ..
-y Work with members. .,
- Library list
gk User libraries
=i PROJK lbrary

BRI PR Oz, Hib, test

&) i*{ iSeries Commands

= &8 iSeries Jobs

[#-*y IFS Files =

You have created a personal development library (single developer sandbox) and
now you are ready to begin [‘Exercise 3.2: Creating an iSeries Project.”|

Exercise 3.2: Creating an iSeries Project

Before iou begin, you must complete [“Exercise 3.1: Creating a scratch library” on|

iSeries Projects are projects that are dedicated for holding iSeries source members
destined to be pushed and compiled on an iSeries machine. They follow the
Workbench paradigm in that they have a special perspective, the iSeries Projects
Perspective, which is dedicated to showing and working with these projects. When
a new iSeries project is created three properties need to be associated with it. These
are an iSeries Connection, an Associated Library, and a Build Style.

To create an iSeries project:
1. Click File > New > iSeries Project on the workbench menu.

dp iseries Projects - PAYROLL.RPGLE - WebSphere Development St

File Edit Source MNavigate Search Project Run  ‘Window Help
d = Project...
eries Project
- I_ﬁ iSeries Source Physical Fi
() Series Source Member

Ctri+F4
Ctri+-Shift+F4

G+

= Example...

Chr4-ShifE-5

=\ Other...

The iSeries Project page opens.
2. In the Project name field, type MyProject.
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iSeries Project
Create a new iSeries project that maps to an iSeries bbrary. %

Profect name: | MyProject]

~Project contents
¥ Use default

Directory: IC:'{D(!EUI’!‘EﬁtS and Settingsistackham|My Dotument: Browee, ..

N

Specify the name and location of the iSeries project being created. An iSeries
project allows For local development, while performing builds on a remote iSeries
host machine,

<eack [ mext> | rrsh | Cancel |

3. Click Next.
4. Select your connection from the Connection list, for example, s400a.

The property iSeries connection allows for remote access to the iSeries host
machine, and handles various aspects, including user ID and password
authentication to the remote host. It also provides the initial environment for
builds, including the base library list.

5. In the Associated library field, type PROJXX

cﬁw New .:
iSeries Project Properties

Specify the iSeries project properties.

Xl
e
Connection: ~[s400a =] new.. |
Lo

Associated library; | PROJXX Browse. ..

Specify the conmection and library name to associate with this iSeries project. The
connection allows For remaote access to the iSeries host machine, Cods changes
made locally are pushed to the spacified remote library, That library is also used far
performing builds on the remote host,

<Back | mext> [ Fesh | concel |

The associated library is the library on the iSeries system that your iSeries
project maps to.

6. Click Next.
7. Under Active build style, select CL Program.
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iSeries Project Properties
Select and configure the active build style For this project. %
Active build style:
Configure, ..
Command 4'
FMOMNE

This build style will upload CL programs specified in the configuration, compile them,
and then run them to build this project. The compile commands can be automatically
generated,

Provided by I6M plugin "iSeries Projects - Remote Build Styles Plugin® version 5.1.2

7% -E;:i": """ El MewE = I Firiish Canicel I

The property build style determines how a given iSeries Project is built. It
determines how source physical files and members are pushed to the remote
host, and how these members are compiled there.

8. Click Finish.
This will create an empty iSeries project that you have to populate. This is
useful when you are creating new iSeries members from scratch and you don’t
have them already on a host.

v X

You have created an empty iSeries Project and now you are ready to begin
[Exercise 3.3: Creating source file and a source member.”|

Exercise 3.3: Creating source file and a source member
Before iou begin, you must complete [“Exercise 3.2: Creating an iSeries Project” on|

page 23.

You can create a source physical file and a source member for your project.

To create a source physical file:
1. Right-click your iSeries Project.
2. Click New then click iSeries Source Physical File on the workbench menu.
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The iSeries Source Physical File page opens.

x

iSeries Source Physical File

Create a new local source physical file under an iSeries project. %

Enter or select an iSeries Project:
| MyProject

& <o

#-Tmr MyProject

# = RemaoteSystemsCannections
[+-{z% RemoteSystemsTempFiles
¥ @ s400a_RSELABXX

File name: IRPGﬁIe
Advanced == |

Select an iSeries project and enter the name of the new source physical file being
created, The source physical file will map to a folder under the selected iSeries
project,

< Back | Next> |[ Finish | concel |

3. Enter a name for your file in the File name field.
4. Click Finish.
The file is added to your project.
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=l MyProject;

- E§ RPGFILE
T 5400a_RSELABXX

Next add a member to the file that you just created.
Right-click your iSeries source physical file.
Click New then click iSeries Source Member on the pop-up menu.

. v x || _]welcome [ S PAYROLLG RPGLE ><|
& & |g§}}| o Row 211 Column 35 It
=1z MyProject

L i =\ Prail
-3 s400a_RSE B Project...

GoInto :
Open in New Window T iSeries Project

Shiow In Remote Systems View % iSeries Source Physical File

.|'j!"' iSeries Source Me

Copy

E Paste = Example. .

8 Do =\ Other...
Mo

The iSeries Member page opens.
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iSeries Member
Create a new local source member under an iSeries project.

Enter or select a source physical file under an iSeries project:
| MyProject/RPGFILE

- el

= Tas MyProject

: @ (= RPGFILE

[+-{z RemoteSystemsConnections
113 RemoteSystemsTempFiles
T 5400a_RSELABXYX

Member name:
Source type: | RPGLE ~]

Select an iSeries source physical file, and enter the name of the new source member
being created, The member will map to & file in the folder representing the selected
iSeties source physical file,

= Back | Next > | Finish I Cancel I

7. Enter the name of the member in the Member name field, for example,

RPGSRC.
8. Enter the source type in the Source type field, for example, RPGLE.
9. Click Finish.

The member is added to your project.

el i s
[=1-Tr MyFroject
== RPGFILE
s @RGSR RPGLE

- Tmr 5400a_RSELABXY

You can now double-click the member to open it in the editor.

You have populated the iSeries Project with a source physical file and a source
member and now you are ready to begin [“Exercise 3.4: Importing members into|

your project.”

Exercise 3.4: Importing members into your project

Before you begin, you must complete [‘Exercise 3.3: Creating source file and a|
[source member” on page 25|

28 iSeries Projects



You can also import remote objects into an existing iSeries project. You can use the
Import Remote Objects action or the Add to iSeries Project action.

To import remote objects:
1. Right-click your iSeries Project.

2. Click Import Remote Objects on the pop-up menu.

- X ' | Welcome
='w"‘= Row 1
D |
Mew »

Go Into
Open in New ‘Window

-Ta s400a_RS

Import Rem cts...
Show Remote Objects

3. Expand *LIBL.

4. If you see a logon display, enter your user ID and password.
5. If you don’t see RSELABxx in the library list, you will need to create a library

filter.
a. Expand Work with libraries.

b. Type RSELABxx for the Library name.

c. Click OK.

&P Import Remote Objects

Select remote objects to download,

x|

| conssre

=l E s400a
= :%‘ ‘“Wark with libraries...
=3 *LIBL
-, Qsvs.Hib.prod-sys
-, Qsvs2.*ib.prod-sys
& i, QHLPSYS. ¥iib.prod-sys
-, QUSRSYS,*lib,prod-sys
[ ﬂ} QGPL, Mib. prod-usr
-, WSSLABKK . *ib.prod-usr
= i, RSELABXX. *iib.prod-usr
1 By COMPARE.*file.pf-src
By QEBLLESRC *file. pf-src
= E) QeLsrRC #ile.pf-src
- [E) Qcmpsre, *file.pf-src
=B c
RET] c
1 By QRPGLESRCP, *file.pf-src
&l Bl RPGFILE. *file.pf-stc

6. Expand the library that contains the source files that you want to import. In

this case select RSELABXX.

7. Select the source physical files QDDSSRC and QRPGLESRC to be added to
your project. You can use the Shift key to make multiple selections.

8. Click OK.
The selected files are downloaded.
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@ Operation in progress. ..

Object download: downloading PAYROLLG ...

The project now shows the copied files and they are ready for you to work
with.

v X
b u|@| K&
=il MyProject
. -2 qopssre

.
. -5 reeFILE
AT s400a_RSELABKK

You have added existing members to your iSeries Project and now you are ready
to begin [“Exercise 3.5: Selecting the build style.”|

Exercise 3.5: Selecting the build style

iSeries Projects

Before you begin, you must complete [“Exercise 3.4: Importing members into your]
[project” on page 28

So now that you know how to populate your iSeries Project, you could next
disconnect and edit and verify the files on your workstation. Let’s assume that you
did just that but in this case you changed multiple members and that you want to
build (compile) the full iSeries project.

Once you are done with changing the source locally, you are ready to build the
project. But before you submit a build, you should understand something about
build styles.

Associated with each iSeries project is a Build Style which determines how source
members in that project will be pushed and compiled on the host. A build style is
a set of actions that provide push and build operations for a given iSeries Project.

There are three IBM-supplied build styles:

*NONE
This build style contributes no actions and is useful if you want to disable
the menu items associated with a build style. This style will always be
available.

Command
The command build style contributes the following actions to the Remote
Actions menu:

* Push Changes — Pushes any new or changed resources found in the
selected project. An item is changed if it has been updated locally since
the last time it was pushed, either by Push Selected or Push Changes.



The first time it is done, all resources are uploaded to the associated
library. Each subsequent upload is incremental.

* Push Selected — This action uploads all selected resources and their
children to their corresponding iSeries source files and members in the
associated library. It creates any resources that do not exist. It will
overwrite any changes that have been made on the server only if
confirmed by the user. Use this action to force the contents of the
associated library to match the workspace.

* Submit Build Command — Submits the command found in this build
style configuration to the server.

CL Program
This style uploads the COMPILE.CLLE and BIND.CLLE members from the
source file that you designated in the style configuration for this project. It
then compiles and runs them to build this project on the server. This build
style contributes the following actions to the Remote Actions menu:

* Push Changes — Pushes any new or changed items found in the
selected project. An item is changed if it has been updated locally since
the last time it was pushed, either by Push Selected or Push Changes.
The first time it is done, all resources are uploaded to the associated
library. Each subsequent upload is incremental.

* Push Selected — This action uploads all selected resources and their
children to their corresponding iSeries source files and members in the
associated library. It creates any resources that do not exist. It will
overwrite any changes that have been made on the server only if
confirmed by the user. Use this action to force the contents of the
associated library to match the workspace.

* Submit Build — Submits a job to compile and run the iSeries Project on
the server using the COMPILE and BIND programs from the source file

you specify.

Each iSeries Project can have only one active build style. This can be configured
through the properties page for that project (right click on the iSeries project and
select Properties).

By default, when a new iSeries project is created it has the CL Program build style
associated with it. This can be changed by going to Window > Preferences > iSeries
Projects > Build and Compile.

Once submitted, a build can be monitored through the iSeries Build Status View.
This view can be set to update at regular intervals and monitors all iSeries Project
build jobs that you have submitted. Also compile errors can be retrieved from that
view by right-clicking on the submitted build and selecting the Retrieve Errors
action.

You have selected a build style for your iSeries Project and now you are ready to
begin [“Exercise 3.6: Submitting a build.”|

Exercise 3.6: Submitting a build
Before iou begin, you must complete [“Exercise 3.5: Selecting the build style” on|

page 30.

Note: You must have a build style defined for your project before you can
compile.
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Besides compiling a single member like in [“Exercise 2.4: Compiling a member” on|

page 17,[you can compile the project in full. The actual compile behavior depends

on the Build Style associated with the project. The default build style for iSeries
Projects is the CL Program Build Style.

This build style will generate a COMPILE.CLLE member in a QCLSRC file that
will contain a compile entry for each source member in the iSeries project.

You can verify or change the configuration of a build style. You can specify the
name of the source file to hold the COMPILE.CLLE member and whether or not
you want to automatically push changes and re-generate the COMPILE.CLLE
member before a push.

To compile a project in full:
1. Right-click the iSeries Project and click Remote Actions > Submit Build.

v x|/ Jweome | Zpavrolicrp... | #reasre
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New » 100
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Open in Mew Window
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| Lﬁ " Show Remote Objects
r_% gp; E2ycopy
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E1E RPGF $8 Delete
B s o F Move..,
[+ T 5900a_R Lot
iSeries Project Wl E2gImport... uence numbers have be:
e A n,
JfE Remote Sys eyExport
D e o Close Project ies Job Status
5 B s4008 Refresh Jme Submitted | 30b
ity i5eri Femote Actions work With Compile Commands. ..
RS 'Ef"; A
B Team » ot Compile
) Compare With »
&9 iy Generate COMPILE. CLLE
o L Replace With 3
— = Restore fram Local History, .. Push Ch
Remote Systems Bch Samges
—_—" Properties

Submit Build

Now the connection will be activated and you may be prompted for a user ID
and password if you disconnected.

2. Enter your user ID and password.

The changes are pushed to the iSeries. (For the first time all changes are pushed
to the iSeries. Subsequent builds only push changed files.)



Progress Information

@ Pushing Changed Resources.

HENNRNERERER %
PROJZJQDDSSRE

3. This action, with the default configuration, will perform all of the following:
a. Generate the following COMPILE.CLLE member:

\Welome | ZPAVROLLGRPGLE | //RPGSRC.RPGLE ﬁ x

Row 1 Column 1 Replace

000100 pycH i
000200DCL ¢FAILED TYPE (*DEC) LEN (10 0) VALUE (0)
000300 DCL &FAILEDSTR TYPE (*CHAR) LEN (10)

000400

000500 CHGPE SRCEILE (PROJXX/QDDSSRC) SRCMBR (EMPMST
000600 T)

000700 MONMSG MSGID(CPFOD00) EXEC (DO)

000800 CHGVAR VAR (SFAILED) VALUE (sFAILED + 1)
000900 ENDDO

001000

001100 CHGPF SRCFILE (PROJXX/QDDSSRC) SRCMER (PRIMST
00l1200T)

001300 MONMSG MSGID(CPFOD00) EXEC (DO)

001400 CHGVAR VAR(SFAILED) VALUE (§FAILED + 1)
001500 ENDDO

001e00

001700 CHGPF SRCFILE (PROJXX/QDDSSRC) SRCMER (REFMST
001800 T)

001200 MONMSG MSGID (CPFOD00) EXEC (DO)

4] | L'ﬂ

b. Display a Build Job entry in the iSeries Build Job Status View indicating that
a build has been submitted. The entry will look like this:

& i5eries Job Status

¥ |Refresh Interval: 10 seconds

Tasks (iSeries Commands Log |iSeries Error List |iSeries Job Status |

You can change the Refresh Interval using the side arrow next to the
Refresh Interval field shown above.

c. Push all project changes to the host, including the newly created
COMPILE.CLLE member.

d. Compile COMPILE.CLLE into a program in the QTEMP library.
e. Run it against the source in the PROJXX project library.
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f. If there where any errors during the submitted build (see PAYROLL), after
the job completes, refresh the iSeries Job Status View, then right-click on the
entry in the iSeries Job Status View, and select Task Actions > Retrieve
Errors.

This will open the iSeries Error list and you will be able to double-click the
error to open the corresponding member.

You have built your iSeries Project and now you are ready to begin
[Showing remote objects.”|

Exercise 3.7: Showing remote objects
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Before you begin, you must complete [‘Exercise 3.6: Submitting a build” on page]

You can refresh your iSeries Project Navigator and look at all the remote objects.

To show remote objects:
1. In the iSeries Project Navigator right-click the iSeries Project.
2. Click Show Remote Objects on the pop-up menu.

- X |_] ‘Welcome

I = I ‘ Row
Mew »
Go Into

Open in New Window

Import Remoke Objects. ..

Show Remota Objects

[2yCopy
ﬂ Paste
8 Delete

Mave...
Rename

3. Your iSeries Project Navigator will now look like this:

¥ Efj QDDSSRC (Local/Remal
- Elf QRPGLESRC (Local[Ren
5 RPGFILE (Local/Remate
- [EF EVFEVENT. *file.pf-dta
- MSTDSP."‘EiIe.dsEf EREr
g PAYROLLG. *parm. rpale
-l 54 |

00a_R.SELAEXX

4 | »
iSeries .. | Navigator |Bookmarks

You have seen the PAYROLLG program obiject in the iSeries Project Navigator and
now you are ready to begin [‘Exercise 3.8: Filtering out remote objects” on page 35




Exercise 3.8: Filtering out remote objects
Before iou begin, you must complete [“Exercise 3.7: Showing remote objects” on|

You can filter the objects to remove the remote only objects from the view.

To filter out remote objects:

1. Go to the iSeries Project Navigator toolbar.

2. Click the drop-down arrow.

3. Click Show > Remote Obijects on the drop-down menu.

@ v x || Jwekome | Zpamolt... [ Free.. x

Sort bl Column 1
4 v Local Objects

+ Remote Objects

= [ QDDSSRC (Lo ¥ Link with Editor

- QRPGLESRC ( Expand &l

-5 RPGFILE {Loc.
-2 EVFEVENT. *fil
ﬁ" MSTDSP.*files s show Local/Remote Flags
(5§ PAVYROLLG. *parmrpgre
- Tm 5400a_RSELABKS

o Collapse Al

4| | »

iSeries .., [Navlgatorlﬂnohnarks Fequence numbers have &

This would remove all objects that are only remote from the view.
4. Expand QCLSRC, QDDSSRC, QRPGLESRC and RPGFILE
Now you see only Local/Remote objects.

=155 QCLSRC (Local/Remote)
[ COMPILE.CLLE {Local/Remote)
= 1E§ QDDSSRC (LocaljRemate)
[ EMPMST.PF (Local/Remote)
[ MSTDSP.DSPF (LocalfRemote)
% PRIMSTPF (LocalfRemote)
0% REFMST.PF (Local/Remote)
0% RSMMST.PF (Local/Remote)
= E§ QRPGLESRC (Local/Remote)
[ PAYROLL.RPGLE (LocalfRemate)
~.[% PAYROLLG.RPGLE (LocalfRemate)
=1 5§ RPGFILE (Local/Remote)
! ¥ RPGSRC.RPGLE (Local/Remote)
(@ s4008_RSELABIY

Now you want to remove the Local/Remote Flags from the view.
5. Go to the iSeries Project Navigator toolbar.
6. Click the drop down arrow.
7. Click Show Local/Remote Flags on the pop-up menu.
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P o
6 iSeries Project

v x| wek.. | Zraw

Sort »
Show »
: —
% COMPILE.CLLE (LocalfRemo = -inkwkh Editor

=& QODSSRC (LocaljRemote) Expand Al
e Collapse Al

% EMPMST PF (Local/Remote)
- MSTDSP.DSPF (LocalfRemot
I PRIMST.PF (Local/Remote)
I REFMST PF (Local/Remate)
L[ RSNMST.PF (LocalfRemoate)
=5 QRPGLESRC (Local/Remote)
- I¥ PAYROLL RPGLE (LocaljRemote)
-1 PAYROLLG.RPGLE (LocaliRemote)
=5 RPGFILE {Local/Remate)
% RPGSRC.RPGLE {Local/Remote)
T 5400a_RSELABXY Sequence n

iSerles Project Navigator |Navigator | Bookmarks

|
| @ iserise Tk Shabie

Now you see your objects without the flags to indicate whether the object is

local, remote

= & [Series Project

or both local and remote.

: L[y COMPILE.CLLE

- =[5 qopssre

: -y EMPMST.PF
[y MSTDSP.DSPF
-y PRIMST.PF
.-y REFMST.PF

| '}y RSMMST.PF

- =15y qreeLESRC

i -y PAYROLL.RPGLE

~y PAYROLLG.RPGLE

. = E rreFiE

. |-y RPGSRC.RPGLE
#-lmp s4008_RSELABXX

You have filtered the objects to remove the remote only objects from the iSeries
Project Navigator and removed the local/remote flags from the view and now you

are ready to be

in [“Exercise 3.9: Changing PAYROLLG again and submitting|

fanother build.”|

Exercise 3.9: Changing PAYROLLG again and submitting another build
Before iou begin, you must complete [“Exercise 3.8: Filtering out remote objects’]
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on page 35,

Now let’s chang

e PAYROLLG again and the submit another build. You will see

that only the changed file is pushed to the iSeries.

To change PAYROLLG and submit another build:

1. Double-click

PAYROLLG in QRPGLESRC.

In the Editor add a comment line to the source.

2.
3. Save the file
4

and close the Editor.

Right-click the iSeries Project MyProject and click Remote Actions > Submit

Build on the

pop-up menu.



5. Only the member and COMPILE.CLLE are pushed to the iSeries.

Progress Information k

\;-:) Pushing Changed Resources.

AREEEENENEEENNEENEENENEENNENNENNNNEEREER
PROJZXJORPGLESRC(PAYROLLG)

You have pushed only the changed file to the iSeries.

Module recap

You have completed [Chapter 3, “Module 3. Creating and Building an iSeries|
[Project,” on page 21|You have learned how to:

* Create a personal development library (single developer sandbox)
» Create an empty iSeries Project

» Populate the empty iSeries Project

» Select a build style for the iSeries Project

* Build the iSeries Project

* View all the remote objects in the iSeries Project Navigator

 Filter the objects to remove the remote only objects from the iSeries Project
Navigator

* Remove the Local/Remote Flags from the iSeries Project Navigator
» Push only a changed file to the iSeries

Now that you know how to build source you could start an interactive connection
and then run your program interactively. You could also start the iSeries Integrated
Debugger to debug your application. You can do the same run and debug tasks
that are outlined in the Tutorial: Maintaining an ILE RPG application using the
Remote System Explorer.

Finish the tutorial by reviewing the materials in[Chapter 4, “Summary,” on page]
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Chapter 4. Summary

This tutorial has shown you how to use the iSeries Projects perspective in a typical
development cycle for offline application development. After providing you
information about the perspective, the tutorial outlined the development cycle
working offline with an iSeries Project, then elaborated on each step in maintaining
an ILE RPG project-based application.

If you have completed all the modules in this tutorial, you should now be able to:
» Start the product, configure and create a connection to an iSeries system

* Make source available for offline or disconnected development

» Edit and verify source in disconnected mode

* Compile a changed member

» Create a new iSeries project and populate with new source physical files and
members

» Show remote objects or local objects or both
« Submit a build for the entire iSeries project

More information

For more information on the product and the iSeries Projects, see
http://ibm.com/software/adwtools/iseries.
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Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the I1BM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-1BM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2004. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information
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Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.



However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

ClearCase
IBM

iSeries
0S/400
Rational
RPG/400
VisualAge
WebSphere

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX® is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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